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History

The following list shows the dates of each edition of the manual, with the corresponding
OpenView DTC Manager software release. Note that new software updates may occur
between manual releases, so the software you receive with this manual may have a later
version number. The version number given below corresponds to the earliest software

release for which this manual is valid.

Edition Number

Edition 1

Edition 2

Edition 3

Edition 4

Edition 5

Edition 6

Date

June 1991
October 1991
April 1992
February 1993
July 1993

August 1994

Software version number

from A.10.50
from A.12.00
from A12.10
from A14.00
from A14.10

from A.14.20



Conventions

Bold

type

ltalic

Bold text is used for all on-screen text seen by the user in the OpenView
Windows environment.

Type text is used to represent user input to the screen in the OpenView
Windows environment, and all text appearing on terminals operating in

text mode.

Italic text is used for emphasis and for the titles of documents.

Caution

The caution sign denotes a hazard. It calls attention to an operating
procedure, practice, or the like, which, if not correctly performed or
adhered to, could result in damage to or destruction of part or all of the
product. Do not proceed beyond a caution sign until the indicated
conditions are fully understood and met.

Note

A note indicates an important point.
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Naming Conventions

The following table lists the abbreviations used in this manual for certain products.

Name used in this manual What it means

The workstation The combination of the PC, the stack of supporting
software, and the DTC Manager software.

The DTC Manager The HP OpenView DTC Manager software. Note
that this is not the same as the workstation.

OpenView HP OpenView Windows/DOS

DTC 16 HP 2340A

DTC 16iX HP J2062A

DTC 16MX HP J2063A

DTC 16RX HP J2064A

DTC 16TN HP J2060A

DTC 48 or DTC 48/3000 HP 2345A/B

DTC 72MX HP J2070A

DTC ARPA Telnet Express HP 2344A

HP 3000/900 HP 3000 Series 900 systems

HP 9000 HP 9000 Series 700/800 systems

DTC Memory Upgrade Kit HP 2348A




Other Manuails

The following manuals are relevant to installing DTC Manager 14.2 and migrating from
carlier releases of DTC Manager. See Using HP OpenView DTC Manager for a full list of
documentation.

m  HP OpenView Windows 7.2 SNMP Platform User’s Guide (5961-9883)
m  DTC Planning Guide (D2355-95017)
w  Using HP OpenView DTC Manager (D2355-90001)
m DTC Technical Reference Manual (5961-9820)
See Using HP OpenView DTC Manager for information on configuring and managing DTCs,

the DTC Planning Guide for information on planning the use of DTCs in the network, and
the DTC Technical Reference Manual for more technical information.
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Before You Upgrade

1

Before You Start

HP OpenView DTC Manager is a software product that runs on a PC, Other software,
including MS-DOS, Microsoft Windows, and the network layer software, must be installed
on the PC and configured correctly for DTC Manager to run: this software is called the
software stack or the supporting software. The entire software stack, including DTC Manager
14.2, can be purchased ready-installed on a PC (HP 32054F option 201). Alternatively, you
can install or upgrade the software using the instructions in this guide.

Before You Upgrade

s Note the PC’s IP address and computer name.

m  Back up all the essential information on the PC, including the DTC configuration
files. See Using HP OpenView DTC Manager for information.

Before You Install for the First Time

m  Make sure the PC hardware has been set up and all cards have been installed.

m Make sure you have all the software you need. Sce chapter 8 (page 39) for
software and hardware requirements.

m  For new PCs only — make sure the hard disk has been configured and partitioned.
We recommend that you partition the disk as one large drive, rather than two or
more smaller drives.

m Install MS-DOS, Microsoft Windows, and the network layer software, if they have
not already been installed.

Before You Start 1



Overview of Installation

m Obtain a valid IP address for the PC.

m  Obtain a valid computer name for the PC, if your network uses computer names.
See the FTP software documentation for more information.

Overview of Installation

The installation procedure can be summarized as follows:
m Install or upgrade the supporting software (see Chapter 2).
m Install or upgrade DTC Manager (see Chapter 3).
m Resct cach DTC.

= Ifyou have added any new DTCs, add an icon for each new DTC, and configure it
using Initialize Automatic Configuration (see Chapter 5).

2 Chapter 1



Installing or Upgrading the Supporting
Software

This chapter gives guidelines for installing or upgrading the following software needed to
run DTC Manager:

m MS-DOS (see page 4)

m  Microsoft Windows (see page 5)

m  FTP network software (see page 7)
=  OpenView Windows (see page 9)

It is important to install the software in the correct order, as above.

For further details, you should refer to the documentation supplied with these products.

Installing or Upgrading the Supporting Software 3



Installing or Upgrading MS-DOS

Installing or Upgrading MS-DOS

To install or upgrade MS-DOS on your PC, follow the instructions provided with the
MS-DOS software.

We recommend that MS-DOS is installed in the directory C:\DOS, and strongly
recommend that you use MS-DOS 5.0 or a later version.

See page 44 for more information on software compatibility.

4 Chapter 2



Installing or Upgrading Microsoft Windows

Installing or Upgrading Microsoft Windows

If you are not using an HP Personal Computer, read the READ.ME file supplied on the
Microsoft Windows diskettes for information that may affect the installation of the software.

Which Version of Microsoft Windows?

The DTC Manager requires Microsoft Windows 3.1 or 3.11, or Microsoft Windows for
Workgroups 3.11.

We strongly recommend that you use Windows for Workgroups 3.11.

See page 44 for more information on software compatibility.

Installing or Upgrading the Supporting Software 5



Installing or Upgrading Microsoft Windows

Installing or Upgrading Windows for Workgroups
The installation procedure is as follows:

1. Put the Windows for Workgroups diskette 1 in drive A.

Type a:\setup and press Enter.

2. Follow the instructions displayed on the screen.

3. If you are installing Windows for Workgroups for the first time, enter the name for
the directory that is to store the Windows for Workgroups software, when
prompted. We recommend that you use the default directory C:\WINDOWS.

If you have a previous version of Windows or Windows for Workgroups, we
recommend that you choose Upgrade and not Install in a different directory.

4. When the files have been copied, you are asked if you want to modify
AUTOEXEC.BAT and CONFIG.SYS now or later.

Choose Make modifications now.

Reply YES when you are asked if you want to save the changes to
AUTOEXEC.BAT and CONFIG.SYS.

When Windows for Workgroups has been installed, click on Network Setup in the Network
window to check that your network driver has been discovered. It may be an Advanced
Micro Devices AM2100 or any HP LAN Adapter.

If the installation program has not discovered the driver, click on Drivers, Add Adapter.
Choose the name of your driver, and click on Setup.

If the driver has been discovered but is incorrectly configured, select the driver, click on
Drivers, then Setup, and modify as necessary.

The interrupt value should normally be 5, but it depends on your internal hardware
configuration. If you have no other cards in your PC, use the value 5 and ignore any warning
messages.

6 Chapter 2



Installing FTP PC/TCP Network Software

Installing FTP PC/TCP Network Software

Before installation

Make sure you have the following information before you start to install the network

software.

The PC’s IP address.
The type of LAN card installed in the PC.

The PC’s computer name. This identifies the PC to the network. If you intend to
access the PC using nodenames, you must enter a valid, unique value, otherwise
you can use the default value.

Make sure that the ILAN card is connected to the LAN or to a terminator before installing
the network software. If the card is not connected, the network software installation may

fail.

Installation

The installation procedure when you are running Windows for Workgroups 3.11 is as
follows. If you are running Windows 3.1 or 3.11, see also Appendix A.

Installing or Upgrading the Supporting Software

Run the SETUP program on the first installation diskette. This may be done by
using File, Run from the Program Manager, or by double-clicking on
SETUP.EXE from the File Manager.

Choose the default directory for installation.
In the Driver Installation window, choose NDIS for Ethernet.

In the IP Configuration window, fill in the PC’s IP address, the subnet mask (if
any), and the IP address of your Domain Name Server (if any).

In the DNS Configuration window, you must supply a computer name and note it
for future use. It will be the name by which your computer will be identified on the
network. You must also supply the domain part of the ARPA name, and the IP
address of the Domain Name Server (if any).

Answer Yes - Modify to overwrite your existing configuration files.



Installing FTP PC/TCP Network Software

m The network software files will now be installed, and you will need to remove the
first diskette and replace it with the second when prompted.

m Exit from Windows. At this point, if you were previously using ARPA or
ARPA/NS network software, you should remove some lines from
AUTOEXEC BAT and CONFIG.SYS before rebooting,

- From AUTOEXEC.BAT, delete the sections starting with @REM #*LMx**
top and finishing with @REM **LMx** bot. These lines may be marked
“Do not Remove”, but you should ignore that warning,

— From CONFIG.SYS, remove the DEVICE = lines containing references to
NEMM.DOS, TCPDRV.DOS, and PCMPDRV.DOS.

m  Reboot the PC, and watch the screen carefully, to catch any error messages that
might appear.

Checking PC/TCP installation

To check that PC/TCP has been correctly installed, execute a PING from DOS or Windows
with a known IP address (see page 34).

8 Chapter 2



Installing HP OpenView Windows

Installing HP OpenView Windows

To use DTC Manager 14.2, you must also install or upgrade to OpenView Windows 7.2.
Earlier versions of OpenView Windows are not compatible with DTC Manager 14.2.

See page 44 for more information on software compatibility.

1. Put the OpenView Windows diskette 1 in drive A:.
If you are not running Windows:
type win a:\setup and press Enter.
If Microsoft Windows is running;

choose Run from the File menu and enter a:\setup.

2. Choose to install OpenView Windows. In the HP OpenView Applications
window, choose SNMP over TCP/IP Communication. You should not need to
install any other options or SNMP features for DTC Manager.

The installation ends by creating the OpenView group window.

Installing or Upgrading the Supporting Software 9






Installing and Upgrading DTC Manager

This chapter explains how to install or upgrade to DTC Manager 14.2 using the DTC
Manager installation software.

The DTC Manager installation software checks that the other software on the PC is correct
for DTC Manager, and verifies that there is enough memory and disk space. If any of DTC

Manager’s requirements are not met, the installation software displays an error message. If
everything is correct, the installation software installs DTC Manager 14.2.

Installing and Upgrading DTC Manager 11



Running the DTC Manager Installation Software

Running the DTC Manager Installation Software

1. To install DTC Manager, you must run the SETUP program on the installation
diskette.

2. Insert the DTC Manager installation diskette 1 into a diskette drive (assumed to
be A: in this example).

From the Windows Program Manager, select Run from the File menu, type
a:\setup, then press Enter. Alternatively, from the Windows File Manager,
double-click on the SETUP.EXE file on the installation diskette.

Follow the instructions displayed on the screen. The online help for the
installation explains the information needed.

Exit Microsoft Windows, remove the diskette and reboot the PC when told to do
sO.

3. If you are adding a new DTC to the network, you must add the appropriate DTC
icon to the map and then use the DTC Manager’s Initialize Automatic... function
to prepare the DTC’s configuration. See chapter 5 (page 15) for instructions on
adding icons and configuring the DTC.

4, If you are upgrading from an earlier release of DTC Manager, and you have just
upgraded the memory in one or more DTC 48/3000s at the same time, then you
must also update the network map. See chapter 6 (page 29) for information on
how to continue.

5. To use the DTC Manager 14.2 functionality, reset each existing DTC by switching
it off then on again.

Refer to the DTC Manager online help and to Using HP OpenView DTC Manager for
information about configuring terminals and printer connections. The chapters
“Configuring Terminal Ports” and “Configuring Printer Ports” contain detailed examples of
configuring printer and terminal connections to HP 3000/900 and HP 9000 systems.

12 Chapter 3



Configuring the Ready-Installed DTC
Manager

If you buy the ready-installed DTC Manager, all the software has been installed, and most
parameters have been configured by Hewlett-Packard. However, you have to configure
certain networking parameters according to the network you are using. This chapter
explains how to configure these parameters.

Configuring the Ready-Installed DTC Manager 13



Configuring the IP Address and Computer Name

Configuring the IP Address and Computer Name
When you switch on the PC, DTC Manager will start. To configure it:

1. Choose the WinConf icon from the FTP group window.

2. Choose Basic Configuration and fill in the IP address, the computer name, and the
other parameters in that window.

3. Exit from the configuration program.

4. Exit from Windows and reboot the PC.

See chapter 5 (page 15) for information on configuring and testing basic connections. See
Using HP OpenView DTC Manager for detailed information on configuring DTCs.

14 Chapter 4



Configuring DTCs

This chapter gives a quick guide to configuring the DTC for the first time, and testing
terminal and printer ports.

The basic steps are as follows:

See Using HP OpenView DTC Manager for detailed information on configuring the DTC.

Install the DTC and connect it to the LAN.
Log on to DTC Manager.

Create a new map or modify an existing map.
Add an icon for the DTC.

Choose Configure DTC, Initialize Automatic Configuration from the Control
menu to download a default configuration to the DTC.

Test that the DTC works.

Configure any ports that need a configuration different from the default.

See the Microsoft Windows documentation for information on using Windows. The
Windows help system also contains a tutorial for people who have never used Windows

before.

Configuring DTCs
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Configuring the DTC

Configuring the DTC

Installing the DTC

Refer to the documentation that came with the DTC for details of how to install it and

connect devices.

DTC Manual Part number

DTC 48 HP 2345A Datacommunications and Terminal Controller |D2345-90021
Installation and Service Manual

HP ARPA ARPA Telnet Express Installation Manual D2344-90011

Telnet Express

DTC 16 HP 2340A Datacommunications and Terminal Controller |D2340-90001
Installation and Service Manual

DTC 161X HP J2060A/32062A/J2063A HP DTC 16xx Family 5959-4986

DTC 16MX Installation Guide

DTC 16TN

FZ)TC 72MX HP J2070DTC 72MX Communication Server Installation /J2070—90001 (
Guide

16
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Configuring the DTC
Logging on to the DTC Manager

You must logon to DTC Manager before creating the map and icon. If you are not logged
on, DTC Manager will not be able to use the icons you create to manage DTCs,

1. Choose Local DTC Manager ... from Log On ... in the Control menu.

2. Enter the manager password. The default is DTC.

Creating a Network Map

You must create a network map, or modify an existing one, before you can add DTC icons.

To create a new map, follow these instructions.

Computer
Museum

1. Choose New Map from the File menu.

A new map called untitled is displayed.

2. Choose Save Map as ... from the File menu and enter a name for the map.

Adding a DTC lcon to the Map

You must use the correct icon for the type of DTC: if the icon is incorrect, DTC Manager
will be unable to manage the DTC.

1. Choose Add from the Edit menu, then select Component.
2. Select the correct icon for the type of DTC.

3. Enter the name of the DTC in the Describe window.

The icon is added to the map.

4. Save the changes by choosing Save Map from the File menu.

Configuring DTCs 17



Configuring the DTC
Automatic Configuration of the DTC

Initialize Automatic downloads a default configuration to the DTC that should work in
most situations. If necessary, the DTC can be reconfigured later,

1. Choose the icon you have just added to the map.
2. Choose Initialize Automatic ... from Configure in the Control menu.

3. Enter the following information:

— DTC’s nodename. You must supply a nodename that meets the naming
conventions used on your LAN.

— DTC’s LAN address. The DTC’s LAN address is marked on a label on the
DTC.

DTC 161X on a label on the rear of the DTC
DTC 16MX

DTC 16TN

DTC 16

HP ARPA Telnet Express

DTC 48 on a label inside the front cover }
DTC 48/3000

DTC 72MX on the LAN board

— DTC’s IP address. You must supply a unique IP address for the DTC if you
will be using it for connections to ARPA systems or for extended switching
connections. See Using HP OpenView DTC Manager for more information.

4. Choose OK to save the information.

5. Switch the DTC on.

18 Chapter 5



Testing a Terminal Port

Testing a Terminal Port

This section contains an overview of configuring and testing a terminal connection. You
should refer to the documentation that came with the DTC for detailed information on
testing the DTC.

1. Connect a terminal to a DTC port. The terminal must be configured for the
default port values:

9600 baud

8 bits / no parity

no check parity
XON/XOFF enabled.

2. Switch on the terminal and press Enter.
The default DTC prompt should be displayed: DTGC>.
3. If a system is available on the LAN and you know its IP address or nodename, try

to connect to it by entering one of the following commands at the DTC prompt:
connect <IP address>

connect <system name>

You should be connected to the system.
Reconfiguring Ports
The default values downloaded to the DTC will work for most types of terminal connection.

See Using HP OpenView DTC Manager for detailed information on configuring the DTC’s
ports.

Configuring DTCs 19



Testing a Printer Connected to an HP 3000/900 System

Testing a Printer Connected to an HP 3000/900 System

DTC Configuration

Set the port as a printer port as follows.

1. Select the DTC’s icon, select Configure DTC from the Control menu, then select
Dynamic.

2. Choose the port to configure, and select Printer from the Change Port Type ...
menu.

3. Leave all the other printer port values as the defaults.

4. Save the configuration.

NMMGR Configuration

This section gives an overview of the configuration of the HP 3000/900 to access the printer.
The instructions assume that this is not the first time NMMGR has been run on the system,
and hence that certain values have aiready been configured. If NMMGR is being run for
the first time on the system, or if you need more information on configuration, see
Configuring Systems for Terminals, Printers and Other Serial Devices (32022-61000).

1. Run NMMGR.PUB.SYS.

2. Press Open Config (F3) to open the Main screen.

3. Answer Y to the question “Are you using OpenView DTC Manager?”.

4. Press Save Data (F6) to save the data.

5. Press DTS (F1) to display the Host Configuration screen.

6. Accept the default values for DTSLINK and number of non-nailed terminals.
7. Check the LANIC path is correct.

8. Press Save Data (F6) to save the data.

20 Chapter 5



Testing a Printer Connected to an HP 3000/900 System

9. Press Go to DTC (F1) to dispay the DTC Configuration Selection screen.

10. Choose the type of DTC.

The DTC Configuration screen is displayed.

11. Enter the DTC’s name and nodename, exactly as you configured them in DTC
Manager.

12. Enter the card type for each card in the DTC with nailed devices (printers are
accessed using nailed devices).

13. Press Save Data (F6) to save the data.

14. Enter the number of the card to configure in the To configure a card ... field and
choose Config Card (F4).

15. Assign an ldev number and a profile to the nailed device.

The ldev can be any number between 0 and 2175 that is not already assigned to a
nailed device, or used by the system. The following profiles are suggested:

( suggested profile
Printer without status checking PR18D96
HP printer with status checking PR22D4

For example:

Idev profile

100 PR18D96
101 PR22D4
102 PR22D4

16. Press Save Data (F6) to save the data.
17. Press Validate Link/DTS (F5) to validate the configuration.
18. Exit NMMGR.

19. Reboot the system.

Contiguring DTCs 21



Testing a Printer Connected to an HP 3000/900 System

20. When the ISL > prompt is displayed, enter

IS1> START NORECOVERY

21. Reboot the DTC.

Testing the Printer Configuration

To test the printer connection, you need a file that can be printed. If there is not already
one on the system, create one using an editor such as TDP.

1. Enter the following commands to test the printer.

file prt;dev=1pl
fcopy from=file name; to = #*prt

Where file_name is the name of the file to print.

22 Chapter 5



Testing a Printer Connected to an HP 9000/800 System

Testing a Printer Connected to an HP 9000/800 System

The following software must be installed on the HP 9000/800:

HP-UX 8.0 or later
ARPA Services or Internet Services
HP DTC Device File Access (DDFA).

DDFA must have been installed according to the instructions that come with it, to ensure
that the configuration file templates are in the correct directories for the following
instructions. See DTC Device File Access Utilities and Teinet Port Identification
(B1014-90012) for detailed information on DDFA.

DTC Configuration

To set the port as a printer port, follow these instructions.

1. Select the DTC’s icon, choose Configure DTC from the Control menu, then
choose Dynamic.

2. Select the port to configure, and choose Printer from the Change Port Type ...
menu.

3. Leave all the other printer port values as the defaults.

4. Save the configuration.

DDFA Configuration

Configure DDFA on the HP 9000 as follows. These instructions assume that the following
files exist on the system.

/etc/ddfa/dp
fetc/ddfa/pct

If the files /etc/ddfa/dp and /etc/ddfa/pcf do not exist, proceed as follows.

1. Create the directory /etc/ddfa if it does not exist.
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Testing a Printer Connected to an HP 9000/800 System

2. Copy the following files into /etc/ddfa.

fetc/newconfig/ddfa/dp
[etc/newconfig/pcf

For further information, refer to DTC Device File Access Utilities and Telnet Port
Identification (B1014-90012).

Edit the File /etc/ddfa/dp

Use a text editor such as the Vue text editor or vi to edit the file /etc/ddfa/dp.

Follow the template at the top of the file /etc/ddfa/dp, and add the following information on
a new line of the file.

<DTCIP address > <board/port> <device file name> < port config file >

A L]
— 1 ———{( pbc r—1 { |
- \ ,// Ty
// \.\ ~ /
IP address of DTC DTC Board/Port Device fileused to  Port configuration
‘ access printer file |
| | .~ dpfile | |
| 15.98.130.8 01/07 /dev/dtc1b1p7  /etc/ddfa/pet
L
s DTC IP address
The IP address of the DTC is the first entry in the line.
a DTC board and port
Enter the numbers of the DTC board and port to which the printer is connected.
The format is board/port, and the / is obligatory. There must be no spaces betwcen
board and / and between / and port.
For a DTC 16TN, the board must be 1 or 01.
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Testing a Printer Connected to an HP 9000/800 System

m Device file name
Enter the name of the device file that will be used to access the printer.

We recommend that the name contains the DTC’s name and the board and port
number to make it easy to identify the printer connected. For example,
/dev/dtclblp7.

m Port configuration file
Enter the name of the port configuration file used to configure the printer.

The default file /etc/ddfa/pcf will be correct for most applications and printers. If
you need to change the values, see DTC Device File Access Ulilities and Telnet Port
Identification (B1014-90012).

When you have added the information, save the dp file.

Execute the dp parser

Execute the dedicated port parser (dpp) by entering the following command.
# /etc/dpp Jetc/ddfa/dp -k

This will check the dp file is correct, and start the ocd daecmon.

Printer Configuration

This section explains how to configure a printer using SAM. Refer to the HP-UX
documentation if you want to configure the printer manually using the Ipadmin commands.

These steps are for an HP-UX 9.0 system on an HP 9000 Series 800 system. The process
may differ depending on the version of HP-UX.

1. Choose Printers / Plotters from the SAM main menu.
2. Inthe Printer / Plotter Manager screen, choose Actions - > Local Printer Plotter.

If you are using a character mode terminal the menu bar must be on to use the
actions option. The function key F4 toggles the menu bar on and off.
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3. Choose Add Printer/Plotter Requiring Nonstandard Device File.

4. Complete the Add Printer screen as follows:
Printer name Assign a name to the printer.

Printer model/interface With this field selected, press the Enter key. A
list of models is displayed. Choose the printer
model corresponding to your printer.

Printer device file name Enter the printer device file that you entered in
the file /etc/ddfa/dp file for the DTC printer
port.

5. Complete the other fields as required.

6. Exit from SAM.

Testing the Printer
Use the Ip command to verify that the printer configuration works.

1. Enter 1p -d<printer name> /etc/ddfa/dp and press Enter.
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6

If You Are Upgrading to DTC Manager 14.2

This chapter contains the following information for people who are upgrading to DTC
Manager 14.2 from an earlier version:

m upgrading a DTC 48/3000 to a DTC 48
m updating the network map

m updating DTCs without icons
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Upgrading a DTC 48/3000to a DTC 48

Upgrading a DTC 48/3000 to a DTC 48

If you are upgrading from an earlier release of DTC Manager, you may have to upgrade the
memory in your DTCs.

You must upgrade the memory in:

m every DTC 48/9000 that has not yet been upgraded: the section “Checking DTC
48s for Memory Upgrades”, below, explains how to tell if a DTC has been
upgraded

= any DTC 48/3000 that has not been upgraded, and for which you require all the
functionality provided by DTC Manager 14.2

You do not need to upgrade the memory in:

m DTC16
DTC 16TN
DTC 16iX
DTC 16MX
DTC 72MX
HP ARPA Telnet Express

m a DTC that has already been upgraded

m  a DTC 48/3000 that will only be used in the HP 3000 environment or for
back-to-back connections (extended switching); see the DTC Planning Guide for
more information on extended switching connections

Checking DTC 48s for Memory Upgrades

Use the following method to check whether a DTC has had a memory upgrade. Use the
DTC’s diagnostic mode to check the part numbers of the ROMs on the card in slot 0 and
on the processor card.

1. Connect a terminal to port 0 of board 0 of the DTC, then switch on the DTC and
hold down Ctrl-P while it boots. The terminal will enter the DTC’s online
diagnostic mode.

2. Enter V to display the version number screen.
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3. Check the part numbers displayed on the screen. If the part number of the ROM
on the Serial Interface Card in slot 0 is 02345-80135 and the processor card ROMS
are 02345-80156 and 02345-80166, you know that a memory extension card has
already been fitted.

If you have upgraded the memory in one or more DTC 48s, you must update the network
map to take account of the changes. If you do not update the network map, the DTC
Manager continues to manage the upgraded DTC 48 as a DTC 48/3000. The DTC Manager
automatically updates the configuration and network map for all other types of DTCs.

Updating the Network Map and the DTC Configuration

With OpenView running, take the following steps to update the network map and the DTC
configuration.

1. Make a backup of the DTC configuration files.

2. While running DTC Manager, note the label of the DTC 48/3000 to be upgraded,
then delete its icon.

3. Choose Add, Component from the Edit menu to add a new DTC 48 icon to the
map.

4. Use Describe to label it. Use exactly the same label that was used for the icon you
have just deleted.

5. Choose Configure, Static from the Control menu. Reply Yes when asked to
confirm migration.

6. Reconfigure the parameters as required. Even if you do not wish to change any
parameters, you must select a board or port and click on Configure, then click on
OK in the Device Configuration window.

7. Exit static configuration as usual, using the Done button, and save your
configuration as the permanent configuration.

8. Download the new configuration to the DTC (switch the DTC off and then on
again, or choose Reset LAN board from the Control menu).

9. Save the new map.
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Updating DTC Configurations Without Icons

Updating DTC Configurations Without Icons

It is possible to manage a DTC without having an icon for it on the map, by using
QuickMap. If you have an old configuration backed up, which contains DTCs managed
without icons, you must follow the instructions provided below to update the configurations:

1. Restore the files from the backup using the appropriate tool, for example, the
DTC Manager Restore facility in DTC Manager Options in the File menu.

2. Close the DTC Manager and Microsoft Windows, so that you return to the
MS-DOS prompt.

3. Type dtcmgr and press Enter.

A message is displayed that lists the DTCs that do not have icons.

4. Press Enter to dismiss the message.

5. Create an icon for each icon-less DTC configuration you have restored.
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Solving Installation Problems

This chapter explains how to deal with certain problems that may occur during the
installation or upgrade process, and contains additional information for specific PC

configurations and usages.
a You do not have enough disk space for DTC Manager (see page 32).

m  You suspect that you have a problem with the supporting software:

FTP software (see page 34)
MS-DOS (see page 35) Computer
Microsoft Windows (see page 36) Museum
HP OpenView (see page 36). L

m  You have upgraded OpenView (see page 37).
m  You need to identify the type of LAN card in the PC (see page 38).
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Not Enough Disk Space

Not Enough Disk Space

I you do not have cnough disk space on your PC, you should remove files that are no longer
nceded before you start to install or update any of the software. You require at least
3 Mbyte of spare disk space to upgrade to DTC Manager 14.2.

See page 43 for more information on disk space requirement.

If you are upgrading any of the software in the stack, refer to the documentation that
accompanies it for its disk space requirements,

If you do not have enough space to upgrade to DTC Manager 14.2, follow these guidelines.
m Do not remove the files AUTOEXEC.OV or *.0ODM.

m Run CHKDSK /F or another disk checking utility to detect and fix lost sectors and
other problems on the disk.

m See the MS-DOS documentation for information on which MS-DOS files can be
deleted.

= See the Microsoft Windows documentation for information on which Microsoft
Windows files can be deleted, for example, you could delete any Microsoft
Windows accessories that are not required.

Microsoft Windows 3.1 includes a tool that enables you to delete safely
applications you do not need.

Open the Windows Setup icon and sclect Add/Remove Windows Components ...
from the Options menu. Remove the components you do not need, for example
games and wallpapers. See the Microsoft Windows online help for more
information.

m See the chapter “Managing the OpenView Workstation” of Using HP Openview
DTC Manager for information on which DTC Manager files can be deleted.

m  You can also remove old files from the directories C:\DTCMGR\UPLOAD and
C:\DTCMGR\MONITOR, if you are sure that none of them are needed for
diagnosing problems.
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Not Enough Disk Space

Delete all the files in the temporary directory pointed to by the MS-DOS
environnment variables TMP and TEMP.

If TMP and TEMP are not set, create a directory for temporary files, for example
C:\TMP, then edit AUTOEXEC.BAT to set the TMP and TEMP variables, and
to delete the contents of the directory when the PC boots. For example, create the
directory C:\TMP, then add the following lines to AUTOEXEC.BAT.

set tmp=c:\tmp
set temp=c:\tmp
del c:\tmp\*.*

To give maximum disk space, first back up all the files from the PC’s hard disk,
then repartition the disk so that all the disk space is allocated to drive C:. Refer to
the MS-DOS documentation for instructions on repartitioning the hard disk.

Delete all the TIFF files in \OV\BKGROUND that are larger then 1 Mbyte.

After you have removed the files, you may find it useful to run a disk management tool that
defragments the files on the hard disk to improve the disk performance, such as the DOS 6
Defragmenter tool. If you do not have DOS 6, see your software supplier for information on
other similar tools.

Warning DTC Manager has not been tested with disk compression tools such as

the MS-DOS 6 DoubleSpace.
You can use such tools with DTC Manager at your own risk.
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Checking the Supporting Software

Checking the Supporting Software

If DTC Manager does not work correctly, the first step is to verify that the supporting
software is working correctly.

Problems with the FTP Network Software
To Check that the FTP Software is Correctly Installed
To test the network software, take the following steps:

1. Note down an IP address from your network. This IP address must correspond to
a node that supports the PING diagnostic, for example, an HP-UX system or an
HP MPE/iX system with PING.

2. Choose WPING from the FTP window. Type in the IP address you noted in step 1.
The number of requests sent and received should be be equal. If not, you may have
a problem with your network (or you may have entered a wrong IP address).

If the test is unsuccessful, you should retry several times, as other factors, such as LAN
traffic, can stop PING getting a response. If you do not get a response after several
attempts:

m  Make sure that you are using a valid IP address.
m  Arec there any error messages when you reboot the PC?

m  Check the network software installation and configuration. The network software
installation can be tested by pinging the IP address of the PC you are configuring.
This ping is routed internally by the network software and never gets as far as the
LAN card, but it does help to indicate whether the network software is working
correctly,

s Make sure that you have declared the type of your LAN card correctly during
configuration.

See the FTP network software documentation for more information.
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Checking that MS-DOS is Installed Correctly

In general, if you were able to load the rest of the sofware, MS-DOS is probably installed
correctly. The following procedure will help to verify this, but will not tell you that it is
correctly configured.

1. Type ver and press Enter. The version number of the MS-DOS installed on the
PC is displayed.

2. Type chkdsk and press Enter. Details such as the disk’s volume name, the date it
was created, disk space usage and memory information are displayed.

The results of the two commands depend on the version of MS-DOS, and how the
PC has been configured, but should look something like this:

If the two commands do not produce the expected results, you must correct the installation
of MS-DOS. Refer to the documentation supplied with MS-DOS for information.

R

CAWINDOWS>ver

MS-DOS Version 6.00

C\WINDOWS>chkdsk

Volume MS-DOS_§ created 10-06-1992 11:02a
Volume Serial Number is 1AC1-7C77

83716096 bytes total disk space

81920 bytes in 3 hidden files

112640 bytes in 38 directories
66752512 bytes in 1718 user files
16769024 bytes available on disk

2048 bytes in each allocation unit
40877 total allocation units on disk
8188 available allocation units on disk

651264 total bytes memory
623552 bytes free

CAWINDOWS>
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Checking Microsoft Windows is Installed Correctly
Proceed as follows to check that Microsoft Windows is correctly installed.

1. At the MS-DOS prompt, type WIN and press Enter to start Microsoft Windows.
2. Choose Help to display the Help Menu.

3. Choose About Program Manager to display information about Microsoft
Windows.

—~ The version number should be 3.1.
-~ The mode should be 386 Enhanced.

- The Free System Resources should be 70% or higher.

If the version number, mode and free resources are correct, you can assume that Microsoft
Windows is installed correctly and proceed with the next step of the DTC Manager
installation. If the version number, mode or free resources are not correct, you must correct
the Microsoft Windows installation. Refer to the documentation provided with Microsoft
Windows.

Checking HP OpenView Windows is Installed Correctly
Proceed as follows to check that OpenView Windows is correctly installed.
1. With Microsoft Windows running, start OpenView by choosing the OVWIN icon.

2. Choose Add from the Edit menu.

3. Select any symbol from the components in the Add window, then point and click
anywhere in the map area (the large area on the left of the screen). The symbol
appears in the map area.

If OpenView starts and you can create new symbols, you can assume that OpenView
Windows is installed correctly.
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If You Upgrade OpenView Windows

You must re-install the network map symbols used by DTC Manager from the DTC
Manager master disks if you upgrade your workstation with a new version of OpenView
Windows after you have installed DTC Manager.

1. Close Microsoft Windows and return to the MS-DOS prompt.
2. Place the DTC Manager diskette labeled OVDTCMGRU1 in drive A:.
3. Typewin a:wsetup and press Enter.

4. Choose Install HP OpenView DTC Manager Additional Tools. Lomputer

Museum

5. Choose Re-initialize a proper running environment.

6. Reboot the PC to run DTC Manager.

The appropriate configuration files are updated, if necessary, to correctly run
DTC Manager.

7. Remove the diskette from drive A:, and reboot the PC.
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Recognizing Your LAN Card Type

Look at the LAN Card

If you do not know which LAN card you have, the LAN card manufacturer may have
provided diagnostics software that will identify the card. Otherwise, you must open the PC
and look at the card itself. The LAN card may have an identifying label or mark in either of
the following places.

m  Look at the metal plate that is used to hold the card inside the PC. There may be a
label on the plate that identifies the card type.

m Look at the card itself, to see if the name is printed or marked.
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Hardware Requirements

You can use any PC as the DTC Manager 14.2 workstation, provided that it:

has an Intel 386 or 486 processor (we recommend a 486)

has at least 4 Mbytes of RAM in addition to base memory (we recommend 8
Mbytes)

has all additional RAM set as extended memory
is compatible with Hewlett Packard PCs
supports the software specified on page 44

has sufficient free disk space for the DTC Manager code, and for uploads and
configuration files (see page 43 for more information)

These requirements apply to PCs running only DTC Manager. If you want to run other
OpenView applications at the same time, you may need to have increased memory and disk
space, and are recommended to use a 486-based PC.

If the performance of the workstation is critical to the operation of your network, use a
486-based PC with a minimum of 8 Mbyte RAM.
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Software Requirements

Software Requirements

To install DTC Manager 14.2 successfully, you must have the correct versions of each of the
layers of software. Do not start to install unless you have the correct software for each layer.
The following software is required:

= MS-DOS 5.0, 6.0, or 6.2

m  Microsoft Windows for Workgroups 3.11 (strongly recommended), or Microsoft
Windows 3.1 or 3.11

w FTP PC/TCP network software
& OpenView Windows 7.2
The DTC Manager installation software verifies that you have the correct versions of each

software layer before it installs the DTC Manager software. If there are any problems, the
installation routine will not proceed with the installation of the DTC Manager software.

MS-DOS 6, DoubleSpace and MemMaker

DTC Manager 14.2 has been tested with DOS 6 and works correctly. However, it has not
been fully tested with MemMaker, or with DoubleSpace or other disk compression utilities;
and it is not guaranteed to work in conjunction with these products.
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Hardware for HP Vectra PCs

Hardware for HP Vectra PCs

The following Hewlett Packard hardware has been tested with DTC Manager. See your
local HP representative for information about ordering,

HP 386 or 486 PCs

Monitor and graphics card| VGA or SuperVGA

LAN card HP ThinLAN (HP 27252 A)
HP ThickLAN (HP 27252 A)

HP EtherTwist (HP 27247 B)
internal EtherTwist or ThinLAN card.

Mouse HP mouse

Memory At least 4 Mb RAM (8Mb recommended) in addition to base
memory

Hard disk 85 Mbyte or larger hard disk
See page 43 for more information

Printer See “Printers” (page 42) for more information

Hardware and Software Requirements 41




LAN Interface Card

LAN Interface Card

DTC Manager is supported on ThinLAN, ThickLAN and EtherTwist networks. The LAN
interface card must be configured to use I/O address 300 (hex) and interrupt level 5 (some
PCs, for example Compaq PCs, may also use interrupt level 3).

This may involve setting switches on the card: see the documentation supplied with the card
for more information. If you do not set the correct interrupt level in the network layer
software, DTC Manager 14.2 will not work until you have corrected it.

Printers

Any printer that can be driven by the Microsoft Windows THINKJET.DRYV printer driver
can be used, for example:

— HP ThinkJet
— HP QuietJet.

-~ DeskJet.

The printer must be configured to use:
m the parallel interface and cable HP 24542D

m the port LPT1.
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Disk Space Requirements

Disk Space Requirements

The DTC Manager can support up to 150 DTCs. The following table gives estimates of the
disk space requirements for different numbers of DTCs, though the actual space required
will depend greatly on the configurations involved. Processor, memory and disk

requirements are also given.

Note that these figures are NOT definitive, and are given for guidance only.

| Number of DTCs 50 100 150
CPU recommended 486
Memory Base + 8Mb

Code 10 Mb 13 Mb 16 Mb

Other software 38 Mb 38 Mb 38 Mb
Uploads and traces 17 Mb 34 Mb 51 Mb
Total disk space 65 Mb 85 Mb 105 Mb
Size of hard disk 80 Mb 160 Mb 160 Mb

The following assumptions have been made in calculating the figures:
Code = PC code + download + configuration files.
Other software = all PC software except DTC manager.

Uploads and traces = two 1 Mbyte traces are on the disk, and 5% of the installed
DTCs have a DTC upload stored on the PC.
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DTC Compatibility Matrix

DTC Compatibility Matrix

The following table shows the versions of software required for the versions of DTC
Manager that are currently supported.

DTC 14.0 14.1 142
Manager
OpenView B.01.01 B.01.01 72|
MS 3.0a 3.1 3.0a 3.1 WFWG 3.11
Windows Win 3.1

Network ARPA ARPA ARPA ARPA | PC/TCP or
B.02.00 B.03.00 B.02.00 B.03.00 other
ARPA | ARPA/NS| ARPA | ARPA/NS| Winsock

B.03.00 2.5 B.03.00 2.5 NDIS
ARPA/NS ARPA/NS software
25 25
MS DOS 4.01 5.0 4.01 4,01 5.0
5.0 5.0 50 6.0
| 6.0 6.2

44 Chapter 8



DTC Compatibility Matrix

The following table shows the versions of software required for earlier versions of DTC

Manager.
DTC 6.0 I 105 12.0 12.1
Manager
OpenView 3.0 4.0 4.0 A4 A.04
A.05 A.05
MS 2.11 2.11 3.0 3.0a 3.0a 3.1
Windows 3.0
Network OfficeShare Office Office ARPA ARPA ARPA
Share Share B.02.00 | B.02.00 | B.03.00
B.01 B.02 ARPA
B.03.00
MS DOS 3.2 32 4.01 32 33 5.0
33 33 33 4,01
4.01 401 4.01 5.0
5.0 B
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Obtaining Software

Obtaining Software

You can upgrade existing software or buy new versions. You can obtain Microsoft software
direct from Microsoft or from your local software supplier. Some Microsoft software is also

available from HP.

The DTC Manager 14.2 Upgrade Kit gives you all the correct versions of software for
upgrading existing workstations. It is particularly suited to customers who do not have an

HP support contract.

The following table shows the part numbers of software available from HP. Contact your
local HP sales office for more information.

Software HP part number
OpenView Windows 7.2 HP 32048E

DTC Manager 14.2 HP D2355A

DTC Manager Upgrade Kit HP D1824F option 201
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Installing FTP PC/TCP with Windows 3.1

The installation procedure for use with Windows 3.1 or Windows 3.11 has the following
extra steps in addition to those used for Windows for Workgroups (see page 7). You should
also read the README.TXT file on the DTC Manager installation diskettes for further

information and advice.

m Inthe Add NDIS Entries window, SETUP will add entries to CONFIG.SYS and
PROTOCOL.INL

m Inthe PC/TCP Setup window, you must choose an NDIS driver. It should be an
HP LLAN Adapter or Advanced Micro Devices AM2100.

In addition, you must edit and change the following files:

m In AUTOEXEC.BAT, delete the sections starting with @REM **LMx** top
and finishing with @REM **ILMx** bot. These lines may be marked “Do not

Remove”, but you may ignore that warning,
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m In CONFIG.SYS, you should find four lines similar to the following:

DEVICE=D; \HPNET\DRIVERS\ PROTMAN\PROTMAN.DOS /I:D:\HPNET
DEVICE=D:\HPNET\HPNETDRV\HPLAN . DOS

DEVICE=D: \HPNET\HPNETDRV\NEMM . DOS

DEVICE=D: \HPNET\HPNETDRV\TCPDRV.DOS /I:D:\HPNET

Comment out these lines by placing REM at the start of each line.
In the FTP section below, you should find a line similar to the following:
DEVICE = C:\PCTCP

This line is incomplete, and must be altered to give the full pathname of the
HPLAN.DOS driver. HPLAN.DOS is one of the old drivers mentioned in the
lines you have just commented out. You can copy the HPLAN.DOS file to your
PCTCP directory, in which case the line should now read:

DEVICE = C:\PCTCP\HPLAN.DOS

Finally, locate your old PROTOCOL.INI file, and copy it to your PCTCP directory.
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Cc

computer name
configuration
DTC, automatic
configuring
DDFA
DTCs
LAN card
printer using SAM (HP-UX)
printers
ready-installed DTC Manager PC

D

DDFA
dedicated port parser (dpp)
device file name
DTC board number
DTC’s IP address
port configuration file
defragmenter
device file name
DDFA configuration
SAM configuration
device profile, NMMGR configuration
disk compression tools, warning
disk space requirements
disk space, increasing
documentation
DOS
See MS-DOS
DoubleSpace, warning

dpp
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DTC
automatic configuration
board number, DDFA configuration
configurations without icons, updating
configuring
how to check memory status
installing
IP address, DDFA configuration
LAN address
memory status, how to check
name, NMMGR configuration
nodename, NMMGR configuration
port, DDFA configuration
update config after upgrading DTC Manager
DTC 48/3000
memory upgrade
serial numbers
DTC icon
See icon
DTC IP address
DTC Manager
configuring the ready-installed PC
installing
logging on to
software requirements
upgrading
DTC Manager 14.0 -
part numbers
DTC nodename
DTS, NMMGR configuration
DTSLINK, NMMGR configuration

E

environment variables, TMP and TEMP

F

files, removing when no longer needed
FTP PC/TCP network software, installing
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H

hard disk
partitioning
recommended size
space needed for DTC Manager software
tidying files
hardware address
See LAN address
hardware requirements
HP Vectra
HP DTC Device File Access utility
See DDFA
HP Vectra, hardware requirements

icons
adding to network map
updating DTC configurations without icons
installing
before you start installing
DTC Manager
DTCs
Microsoft Windows
OpenView for Windows
interrupt level
configuring LAN card
incorrectly set
I/0 address
IP address
DTC’s
DTC’s, DDFA configuration
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L

LAN address, DTC’s
LAN card
configuration
I/0 address
interrupt level
LAN card type
discovering
if configured incorrectly
LAN interface card
HP Vectra PCs
LANIC path, NMMGR configuration
ldev number, NMMGR configuration
logging on to DTC Manager

MAC address
See LAN address
map
See network map
MemMaker, warning
memory
how to check if a DTC has been upgraded
Microsoft Windows
checking that it works
installing
upgrading
version of
MS-DOS
checking that it works
environment variables TMP and TEMP
installing
TMP and TEMP
upgrading
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N

nailed devices, NMMGR configuration
naming conventions
network map
adding icon
creating
re-install symbols after OpenView upgrade
update after upgrading DTC Manager
network software, installing
network software,installing
NMMGR
nodename
DTC’s
non-nailed terminals, NMMGR configuration

o

OpenView for Windows
checking that it works
installing
part numbers
re-installing
upgrading
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P

PC, requirements for DTC Manager
PC/TCP, installing
pef

See port configuration file
performance of workstation
PING
port configuration file (pcf), DDFA
printer

device file name

model

name

testing connection to HP 3000/900

testing connection to HP 9000
printers, supported by DTC Manager

S

SAM, using to configure printer (HP-UX)
setup, DTC Manager installation software
software

checking supporting software

compatibility matrix

how to obtain

requirements

T

TEMP, MS-DOS environment variable

terminal port, testing it works

testing DTC configuration
printer connected to HP 3000/900
printer connected to HP 9000
terminal port

THINKJET.DRV

TIFF files

TMP, MS-DOS environment variable

troubleshooting
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U

UNIX, device file name
updating
DTC configurations without icons
upgrading
DTC 48/3000 memory
DTC configurations without icons
DTC Manager
OpenView for Windows
OpenView, must update network map symbols

\'

Vectra, hardware requirements

w

Windows

See Microsoft Windows

See also OpenView Windows
WSETUP
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